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INTRODUCTION

The goal of THE4BEES is to change the behaviour of users in public buildings. To make the energy
consumption visible and experienceable, several sensors will be used to measure temperature,
humidity and CO.-levels as well as controlling devices for the heaters. The measured values cannot
only be shown using tables, but also in a better understandable manner using maps. Today, maps
can be drawn in 2D and in 3D to show current values.

To create such maps, the first step is to draw the building and its interior. Components that are
needed are:

e Structural Elements: e.g. walls, stairs

* Opening Elements: e.g. doors, windows

* Spaces: e.g. rooms with their corresponding values
* Energy-relevant elements: e.g. heaters/radiators

* Sensors: e.g. humidity-sensor, temperature-sensor

* Furniture: e.g. tables, chalkboard

The building will be drawn using the extensible editor for OpenStreetMap “JOSM”.
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PART 1. PREPARATION
PREPARE THE SENSORS AND THE DATA

A+ SENSORS

The very first step here is to place the sensors. Available ones are

* HomeMatic Wireless Temperature/Humidity Sensor, indoor (Funk-Temperatur-/Luftfeuchtesensor,
innen)

* HomeMatic Wireless Radiator Thermostat (Funk-Heizkdrperthermostat)

* HomeMatic Wireless Sensor for carbon dioxide (Funk-Kohlendioxid-Sensor)
* HomeMatic Wireless Shutter Contact (Funk-Fensterkontakt)

* HomeMatic Wireless Rain Sensor (Funk-Regensensor)

* Bluetooth Beacon as “wireless QR-code”

All of the sensors, except of the rain sensor, will be used indoors. Additionally, one small device
(Bluetooth Low Energy Beacon) will be placed near the door of the room. Depending on the
vendor, a beacon comes in many shapes and colors. The image below shows some examples with
a 1-Euro-Coin as reference for their size.

Figure 1 : Beacon shapes and size

The beacon will work as “wireless QR-code” or “central for display”. It has no display itself, but it
communicates using Bluetooth Low Energy (BLE). BLE uses less battery than the classic Bluetooth,
therefore, the beacon’s battery doesn’t need to be changed very often. Using the beacon, a
smartphone with Bluetooth turned on can display the room data, such as the temperature or
humidity. The following images show what information might be shown:
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Figure 2 : Examples for the information a beacon might display (Sources:
http://www.macosxtips.co.uk/geeklets/modules/upload/attachments/Star%20Trek%20LCARS.png,
http://image.rakuten.co.jp/mikiya-gift/cabinet/f61/f6089m04.jpq)

The temperature/humidity sensor should be placed somewhere, where it will not be moved
anymore. It might be good to use some glue or sticky tape to glue it somewhere.

The radiator thermostat can only be placed at a heater, thus its position is forced by the layout of
the room.

The same applies to the sensor for carbon dioxide, this sensor does not use a battery, and
therefore, it needs to be placed in a socket.

The shutter contact should be mounted at the window that is mostly used for ventilation, so that
its status can be checked.
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B+ GET A PLAN OF THE BUILDING

Once the sensors are in place, the building can be mapped/drawn. If available, use a PDF-Plan of
the building that shows the layout of the building. This plan might be more detailed than necessary
and, contrariwise, might miss some important elements.

As a general rule, building plans only contain the walls and spaces and their measures, such as
length, width and height. Doors might be contained in the plan, but windows might not be included.
These need to be drawn into the PDF-Plan. It might be easier to draw them by hand before starting
to map the building using the computer program.

The plan should be updated so that it now should include all walls, stairs, spaces, doors, windows,
heaters, placed sensors as well as the furniture.

An example of a plan might look like this:
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Figure 3 : Examplary building plan (Source : https://upload.wikimedia.org/wikipedia/commons/1/14/Hills-
DeCaro_House_First_Floor_Plan_Post-Fire.jpg)

The plan is mainly self-explaining. Walls, windows, doors, stairs, rooms and some furniture are
drawn in there. The example is for a building with only one floor. If your building has several floors,
ne plan for each floor needs to be done.
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1. Send the plan for georeferencing

To have the plan at the correct position, we need to reference it. This requires skills in
geoinformation and a GIS-software.

The basic principle is that the local coordinate system gets translated into a Cartesian coordinate
system. To keep it easy, most buildings have a positive coordinate system with the origin of 0,0 in
the lower left corner. The image of the building does not know its position on the map or globe.
That’s what we “tell” the building during the georeferencing. Georeferencing includes different tasks,
such as shifting, rotating, scaling and others.

To keep it simple, we assume, only those three were needed. When you load the image, it will be
placed at 0,0 on the globe/map. That point is somewhere in the atlantic ocean near the westafrican
coast (google maps cannot do georeferencing, but this is an example).

Y .

‘....{.. = The first step is to shift the image at the right position.
@ , So, in this case, away from the African westcoast and to
L Sy the correct city and site.
!
e 1= The image might be too big, so it needs to be scaled to
_‘] J the correct size.

Another step is to rotate it according to its real rotation.

Nigeria
{Tr%? /\/ These steps are not performed manually, the user
QLagos . N . . .

defines points on the image and their corresponding
points on the map, thus, the user tells the software,
where the real location of each point is. The software
does the rest. The result is a “georeferenced image”.
Doing it automated instead of manually gets more
precise outcomes.

Initial position
of the image

This part will be done by iISPACE, therefore, please send us the building plan as soon as
possible per email!
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The following steps should be performed for every room (at least the rooms you are allowed to
enter):

1. Check the walls if they correspond to the plan. If a wall is missing, mark it on your plan. If a new

wall was built, draw it.

2. Do the same for windows and doors.
3. Check the stairs, too!
4. Number the rooms in your drawing and write a list of the room attributes, such as: Room name,

room number, room type, etc.
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Figure 4 : How a layout check might look. The attributes can be written in a table.
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3. Measurements

1. Additionally, measure (or estimate) the following values:

1.1. Room height (RH): For every room if the room has just one height, otherwise, do in the
example in the kitchen (one part has a height of 3 meters, one has just 2.5m)

1.2. Window upper height (WU)

1.3. Window lower height (WL)

1.4. Door upper height (DU)

I
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Figure 6 : Definition of the window heights

Figure 5 : Room height, window upper
height and window lower height for
one room

Figure 7 : Example of a room with differing heights
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4. More detail for the project room (sensors & furniture)
If this was done for every room, then the project rooms should get more detailed information:
First, use a plan to map the sensor-locations. In the example, some of the sensors are written with

the whole name, some are abbreviated. Do it your way, but make sure you know what symbol
represents which sensor.

Figure 8 : Sensors

Abbreviations:

THS: Temperature/humidity sensor
CDS: Carbon dioxide sensor

Afterwards, the furniture needs to be mapped, too. Don’t add too many details, the chalkboard and
the tables should be enough.

— Figure 9 : Mapping of furniture

Once you collected all this information, you are prepared for the next steps.
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PART 2: JOSM

PREPARE BUILDING USING JOSM

-
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A+ DOWNLOAD AND INSTALL JOSM AND SET THE LANGUAGE

TH

ke

BE

OpensStreetMap is an open project that enables users to collect geographic data as a map. We will

use its editor to draw the building

map.

Download the JOSM (Java OpenStreetMap) Editor:
http://josm.openstreetmap.de/download/windows/josm-setup.exe

& The installer suggests an installation in your computer’s language. However, in this project, several
countries are taking part and therefore, this tutorial is prepared in English. You might use the installer in
German, ltalian or any other language, but then, the names and menus in the tutorial might look
different. Therefore, we suggest to install JOSM in English! The installer language has nothing to do
with the installation language. The installation language needs to be changed after the installation in the

next step.

-
Installer Language

=

.
“¥ JOSM 10526 Setup

'x Flease select a language.
-

Choose Components

Choose which features of JOSM 10526 you want to install.

|Engish

install, Click Mext to continue,

] Select the type of install;

Or, select the optional

Figure 10 : Choose English as language

components you wish to
install:

Space reguired; 44.5MB

fullsoft Install Swstem w2,50-1

Check the components you want to install and uncheck the companents you don't want to

Start Menu Entry
[] Desktop Icon

[ GQuick Launch Icon
File Extensions

Description

Position your mouse over a component to see ks
description,

[(Eack "Next:»][(:ancel

Figure 11 : Select the full installation
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http://josm.openstreetmap.de/download/windows/josm-setup.exe

F : ~
“¥ JOSM 10526 Setup . —ae=a

Installation Complete »
Setup was completed successfully. x

Completed
- .

Extract: gipeg4.dll -
Output folder: C:\Program Files (x88)J05M
Extract: mingwrn 10.dll
Extract: QtCore.dl
Extract: QtGui4.dll
Extract: Qtietwork4.dll
Extract: Qtwebkit4.dil
Extract: webkit-image.exe
Create shortout: Ci\Userslinstall\AppData\Roaming Micrasoft\Windows\Start Menu'P...
I Completed i I

m

Mullsaft Install Svstem v2,50-1

< Back Cancel

Start JOSM.

JOSM will look like this at startup:

-
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“¥ Java-OpenStreetMap-Editor I

|Date\ Bearbeiten Ansicht Werkzeuge Auswahl Vorlagen Hintergrundbild Fenster Audie Hilfe

Rtase B2y HIIE VAR HN W

¢ OAuth ist jetzt die standardmagige Methode zur Anmeldung.
< Drag & Drop-Unterstitzung fiir den Relationseditor (mehr Infos (en))

einerLinie)

einer Karte an
| © Der Zoom rastet automatisch auf die Standardauflésung des Hintergrundes ein
« Erweiterte Unterstiitzung von verschiedenen Projektionen

e Weitere Neuigkeiten ...

ubersetzt.

Fiir Anfanger

oder die Schaltflaiche Herunterladen driicken ﬁ

Hilfe erhalten

Tatigkeit zu erhalten. Hilfe-Seite.

nachfragen.

= Neue Schaltfliche im Relationseditor um die Relation zu aktualisieren (z.B. nach dem Aufspalten

©» Das Versionsprotokell zeigt die alten und neuen Koordinaten eines verschobenen Punktes auf

@ Genutzte JOSM-Version ist 10528! Aktuell verfiugbare Version ist 10626 (Entwicklung 10773).
# Helfen Sie mit, JOSM in lhre Sprache zu libersetzen! Momentan sind 100% der Programmtexte

« Vorhandene Daten von OSM mittels Vom OSM-Server herunterfaden... im Meni Datei herunterladen

# Onlinehilfe: Hilfe im Meni Hilfe auswahlen oder bei Bedarf F{ driicken, um Hilfe fiir die aktuelle

« Dem deutschen Forum, der deutschen Mailingliste beitreten oder auf help.openstreetmap.org

Die goldenen Regeln von OpensStreetiap:

# Nicht von anderen Karten kupieren!
» Spak haben!

m

www.alpine-space.eu/THE4BEES
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Even if JOSM was installed in English, it might start up in your standard language. This should be

changed (the tutorial will be easier to follow) with “Edit > Preferences” (or Key “F12”):

[ “¥ Java-OpenStreetMap-Editor
icht Werkzeuge Auswahl Vorlagen Hintergrundbild Fen:
Ruckgéangig Strg+Z
®  Wiederherstellen Strg+Y
¥ Kopieren Strg+C ::
[ ] Einflgen Strg+V r
% Merkmale einfligen Strg+ Umschalt+V
By Verdoppeln Strg+D n
f . Entfernen Entf
N LR
| @ Ebene vereinigen Strg+M shi
: B Auswahl vereinigen Strg+Umschalt+M
: B Suchen.. Strg+F
Wk Nach Objekten durch Voreinstellung suchen... Umschalt+F3 ell
B »:  Einstellungen ... F12 Ir :

Then go to “Display Settings” = “Look and Feel” - language. Choose “English” and press “Ok”:

':( Einstellungen

- - [T

Anzeige-Einstellungen
Verschiedene Optionen, die das Aussehen des Programms fesilegen.

| GPS-Punkte I 0SM-Daten I Farberl] Verhalten und Aussehenll

°C

e & Do i @

Begrifungsbildschirm beim Start anzeigen
Objektkennung in Auswahllisten anzeigen
Dynamische Schaltflachen in Seitenmenis
1S0-Datumsformat anzeigen

Matives Dialogfeld fur Dateiauswahl verwenden (schéner, aber ohne Unterstiitzung fir Dateifilter)

Zoom mit Mausrad umkehren

Vergréferungsschritte um den doppelten Mafistab zu erhalten

Verhalten und Aussehen

=

tandard (Automatis
Asturianisch
Belorussisch
Bulgarisch
Katalanisch
Katalanisch {valenda)
[Tschechisch
Danisch
Deutsch

Englisch {Vereinigtes Kénigreich)
Spanisch

Estrisch

Finnizch

Franzosisch

Galizisch

Sprache
)
| T
] Ui
e
ol | IR
|| Expertenmodus

Ungarisch

B || @

Le

Indonesisch
Italienisch

=

Japanisch

n

ischanisch

www.alpine-space.eu/THE4BEES
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JOSM will tell you that it needs to restart. Press “Restart” and wait for it to shut down and start
again.

[ Neustarten o ——— 5

Einige Einstellungen werden erst nach einem Neustart von J0OSM wirksam.

Machten Sie jetzt neu starten?

Once it was restarted, it should be in English.
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B+ INSTALL THE FREE PDF PLUGIN

e Start JOSM
* Open the preferences (“Edit - Preferences” or “F12”)
* (1) Open the plugin-section
* (2) Click on “Download list” (bottom-left)
* (3) Type in “pdfimport” within the search-field
* (4) Check the plugin
* (5) Click “Update plugins”
* Restart JOSM

r'xpreferences v .-"'...m.

Plugins
Configure avaiable pligns.

é’ Plugins | Plugin update policy
= Seard"“lpdﬁmport I q

I PDF pdfimport: Version 32584 (ocal: 32584) (requires: apache-commaons) 4

Import PDF file and convert to ways. More info...

I -2 @ Download list @ Configure sites. ..
|
| opsrtme Lo || Qe || B |

h

www.alpine-space.eu/THE4BEES
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Once installed, the following message will be displayed:

r's'( Update plugins I u

The following 2 plugins have been downloaded successfully:
@ apache-commons (32584)
& pdfimport (32584)

Please restart JOSM to activate the downloaded plugins.

< ok ‘ &) rep ‘

Press ok, then again ok. JOSM will ask again for a restart. Press “Restart”.

www.alpine-space.eu/THE4BEES 16
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Two more plugins are needed. One is called “piclayer”, the other one is named “buildings_tools”.

PicLayer: This plugin is needed to import your building-picture.
Buildings_tools: This tool makes it easier to draw buildings with right angles.

To install both:

* Open the preferences (“Edit > Preferences” or “F12”)

* (1) Open the plugin-section
* (2) Type in “piclayer” within the search-field
* (3) Check the plugin

* (4) Type in “buildings_tools” within the search-field

* (5) Check the plugin
* (6) Click “Update plugins”
* The following message appears:

'.S-( Update p|ug‘Lins mn_g

@ PicLayer (32495)

The following 2 plugins have been downloaded successfulhy:
@ buildings_tools (32639)

& ox

B |

N - _ —

JOSM does not tell you to restart, but do it anyway (File - Restart).

www.alpine-space.eu/THE4BEES
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To make the drawing easier, a preset was defined. This includes all the elements that you need to
draw. All elements should be mapped using closed areas. There are no lines and points defined in

this preset. To im

port the preset:

* Open the preferences (“Edit > Preferences” or “F12”)

* (1) Open the

Map Settings-section

* (2) Press on the “Plus”-sign on the right

CCE= N N L,

Map Settings
Settings for the mao projection and data inferoretation.

| Map Projection | Map Paint Styles | Tagging Presets | File backup|

Sort presets menu alphabetically

Available presets:

Active presets:

%" Internal Preset -
(Motor)Caravan site by ombo

3D Simple Buildings by Tomasz Kedziora ﬂ{EH
WAccess Mapping India by Patrick
Accomodation tag extentions by Jan van
Additional presets for Mtbikers by openm
Addr2 by frecExec

\Advertising devices editor by Barnes33

Animal facilities by Vikings 1

BAR Damage Assessment by joc
Benelux (Mapping in BENELUX) by Marc Ge
Bicycle waypoints by Adiac

Blood donation by 1M!dgard

Boundary stones and milestones by Liibe
%" Building Preset by didier 2020, skyper

Ruildinne Tndnnecia b Kate Thanman
4 UL 3

Allergy by Karsten Hinz ’

Internal Preset resource: /fdata/defaultpreset€,
Building Preset https: /fjosm.openstreetmap.,

ABees F:linterdisziplinaer1l5_THE4BEES\josm'Presd

@ W

4 i 3
E " Reset
Icon paths:

Pi\interdizziplinaeri15_THE4BEES \josm\Presets

® W -+

Expert mode

www.alpine-space.eu/THE4BEES
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* (3) For name, type “4Bees”
* (4) For URL/File, type in:
https://ispacevm38.researchstudio.at/JOSM/4BEES_preset.xml

|

Mame (optional): |4Eees|
URL / File: |htn:ls:fﬂspa::eumSS.resear::hsmdiu.at,."JDSMHEEESJ:lreset.xrnl | = [
| Do || @l |
* (5) Press “Ok”.
* (6) Press “Ok” again and restart JOSM.
www.alpine-space.eu/THE4BEES 19
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E. ZOOM TO YOUR SCHOOL

Now, add the OpenStreetMap layer (Imagery - OpenStreetMap Carto (Standard layer))

“¥ Java OpenStreetMap Editor

miterreg E
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EEEE

File Edit View Tools Data Selection Preset: indows Audio Help

. @ .‘ ﬁ 0 ‘ ‘ li2 Imagery preferences

. Imagery offset

E Bing aerial imagery
@ Mapbox Satellite

= [ | e

Openstreethap (Mapnik Biack & Whit)_f@@tMap Editor
e OpenbStreetMap Carto (Standard layer)

¥ Rectified Image...
News #0F Import PDF file

. MNew picture layer from file...
H =« 2016-07-12 (sta

. Mew picture layer from clipboard

Add imagery layer OpenStreetMap Carto (Standard layer) |

© Big rework of the JOSM core

@ 2016-04-28 (stable version 10161)

ump to the place where your school building is located. For this step, you need the coordinates of

your school building:

* Open Google Maps

* (1) Find your school via search or just zoom to it

* (2) Right click on the building and select “What’s here?”

HTBLu.VA Sportplatz

, .
HTBLuVA Salzburg

Directions from here
Directions to here
What's here?

Search nearby

Print

statten:  Measure distance

* (3) A small window opens in the bottom of the window

* (4) Click on the coordinates

5020 Salzbu

el l'l"—:-.'la.Ll"ll =31

Salzburger Schitzenstralle

ltzlinger Hauptstralie 32

47821150, 13.045374

& R
ek Map data 82016 Google

www.alpine-space.eu/THE4BEES
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* (5) These are the coordinates you need in JOSM. Save them somewhere or leave Google
Maps open:

47.821150, 13.045374

Add a missing place to Google Maps.

To jump to your position, click on the coordinates on the bottom left of the page:

B> 2as e Buave @ I00dAa HEWw

Fo@ 94 T AR =]

> O
. O O . www.alpine-space.eu/THEABEES 21
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The first part until the comma is the latitude, the second part the longitude. Make sure to have a
point as decimal marker in the coordinates, not a comma. For Zoom, write “40”.

Latitude
47.821150
Longitude
113.045374
Zoom (jn metres)
40
URL

|1ttps: /fwww.openstreetmap.org/#map=18/47.82115/13.045374

[ Jump there ] [ Cancel

Press “Jump there”. If the zoom level does not fit, you can use the mouse wheel to zoom in or out
and the right mouse button to pan the map.

Depending on where you jumped, there might be additional basemap-sources available. For
Austria, basemap.at should be used. To use it, go to “Imagery” and choose “basemap.at”.

e i ok DaiaiOeseciioFiBieséenioe WK ko e it ibews TopksDaiaSelestionresebsracesy Wiows> o=

Help.
BA2AS ¢REAY R [N K72
: ") ok

TORBIAREE
TORBRIATEEE

Figure 12: OpenStreetMap Carto Figure 13 : Basemap.at

2 5
. J www.alpine-space.eu/THE4BEES 22

This project is co-financed by the European Regional Development Fund
through the Interreg Alpine Space programme



witerreg B
Alpine Space EEE&

F+ IMPORT YOUR BUILDING PLAN

Now, you can add the georeferenced building plan (Imagery = New picture layer from file..

browse to your image and click “open”.

“X Java OpenStreetMap Editor
Fieﬁﬁ\ﬁn'loekoﬁmr

New offset I

e BAMSYAA ¥ 6M ;«,g--
g
"E

The building plan is now available on the right in the “layers-tab”. As the plan is below the
OpensStreetMap layer, it is not visible. To make it visible, click on the new layer (however you layer

is named) and then on the arrow below. Now, your layer should be visible.

B (=] E [
@ Layers HE
o . rd layer)

] s (1718
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Because of the georeferencing that was done beforehand, the building plan is located directly on top
of the building outline on the map.
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G - DRAW YOUR BUILDING

To start the drawing, add a new layer. This will be the layer you draw on. To do so, click “File -
New Layer”. A new layer is added on the right. This layer must be active to draw on it. It is active,
when there is a small green arrow in front of the name. To activate the layer, click on its name and
the “Activate the selected layer on the bottom”:

= = Layers HE)

=

o = n2.png
" @ . OpenStreetMap Carto (Standard layer)

"» @ , OpenstreetMap Cz

L+ [ ® B

Activate the selected layer | @@l

|EI ﬁ\Q\ Tags [ Memberships

Figure 14 : Make an inactive layer active Figure 15 : Green symbol shows active layer

To pan around on the map, press the right mouse button and drag the image (alternatively: Press
CTRL and use the arrow keys).
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Do cperseenir i N I NN

File Edit View Tools Data Selection |Pu5e|s Imagery Windows Audic Help

EXSas ek
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CHP "EDFSLMAT

Search preset

&
[ch  Searchfor objects by preset.. Shift+F3

I
le=

Preset preferences

Highways
Water
Transport
Facilities
Sports
Man Made
Shops
Offices
Craft
Geography
Annotation
Relations
Buildings
*  ThedBEES

= B¥eaB

a gt
R ating

Structural Elements * 0

Room Elements 4

Others r
Salzburg Hauptbahmhof 77771}
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If you succeeded with the import of the Preset earlier, you can now find the new preset at “Presets”
- “4Bees”
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Because you will need these elements very often, it is useful to put them in the toolbar on top of the
map. To do so, right click on the grey edge and press “Configure toolbar”:

File Edit View Tools Data Selection Presets Imagery Windows Audio Help

BROE

!H ﬂ °] l\ﬁﬂ\ﬂ?‘ﬂwm

Configure toolbar

Follow these steps:

* (1) Scroll down and click on “Separator”.

* (2) Click on the “Arrow”.

* (3) Click on “Presets” and “4Bees”.

* (4) Click on the “Arrow”.

* (5) Press “Ok”.

: Plain?Kematinf;

& ]: # .a(r'ﬁ

v Do not hide toolbar and menu

@ ,« OpenStre:

“¥ Preferences

e

|

- aS

P )

===

Toolbar customization

Toolbar

Cusfomize fhe elements on the foobar.

A split way

%’ Combine Way

a Reverse Ways

I Separator

.
e Imagery offset

I Separator
H Highways/Streets
n Highways/Ways
ﬂ Highways/Waypoints
& Highways/Barriers
I Separator
H Transport/Car

Q Transport/Public Transport

I Separator

“ Fadilities /Tourism

’lP Fadiities/Food+Drinks

2+4

m

Available

- E Data
[+ Selection

3 a |'_—'|---T, Presets
-} Search preset
[}, Search for objects by preset...

- |v2| Preset preferences
}-n Highways

-y Water

}-E Transport

1=l Facilities

4% Sports

- had Man Made
775 Shaps
Offices

i Craft

t- g4 Geography
++- B30 Annotation
H-(0) Relations
+-Buildings
Sb Ry inesess |
-1 Imagery

- GPS

B 1) Windows

- ) Audio

- [y Help

- Mowe down

- Togale GPX Lines
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m

Separator
I pa [ Orthogonalize Shape / Undo

Ead Man Made Historic Places - Mave right

I Separator - Mowe left
L = Move up L4
h Man Made/Man Made i 1' , Separator I - F
p—

[ Expert mode 5 @DK l ﬁc‘.ancel H @I—Hp ]
i T—— — -_—————
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* The 4Bees menu is now available in the toolbar:

Flle Edlt View Tools Data Selectlon Presets Imagery Wmdows Audio Help

............. ZH80 uamumw\u
@J**‘“ i \ I -

These are the tools you will be using the most in combination with the preset:

-
';( * lava OpenStreetMap Editor

File Edit View Tools Data Selection |
BAEE[S 6@

Move or select nades

Draw nodes

Delete nodes

. B NINE
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With “Draw nodes”, you can draw the outline of an element. “Move or select nodes” lets you edit a
drawn element. Or select it to add attributes. With “delete nodes”, you can delete elements.

To draw your first element, select the “draw nodes”-tool and start with some part of a wall or some
window as shown below. Go around that one element and draw as accurate as you can. You can
also zoom and out and pan while drawing. When you come back to the first point, a red dot is
shown. This red dot means, that you can close the object. Make sure to draw only properly closed
objects.

m.:v—vmmwmmmwm - ,_‘ht«v—leaunmhmmmwm
Bg2s ey H IO SQAHN Y Br22s a2y R IHEICRAHYN Wi
i 3 !

=1 [ [

FORIAARE

When your element was finished, you can use the “mode or select nodes”tool to adjust your
drawing.
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The lines might not have right angles. To get right angles, use “Tools = Orthogonalize Shape” (Or
“Qll):

2 Reverse Ways R
7 Simplify Way ShiftsY
{ Align Nodes in Circle o
2" Align Nodes in Line L
#  Distribute Nodes Shift=B
1 Orthogonalize Shape Q I
{0 Create Circle Shift+0
- Merge Nodes M
*T" Join Node to Way J
"§  Move Node onto Way N
= Disconnect Node from Way Alt+)
~=  UnGlue Ways G
"B onoveisppingaress s |
’ Create multipolygon Ctri+B
& Update multipolygon Ctri=Shift=8

Now, you have to tell the element, what it is. Right now, it is only an area, you have to tell it, if it is a
wall, a window, etc. To do so, select the element (activate the select-tool, then click on the 4BEES-
preset in the toolbar and select the correct element):

-";Javaa nStreetMa Edltor
pRBE! SR

File Edit View Tools Data Selection Presets Imagery Windows Audio Help

BAoase ean=v @

M n n ‘ ‘ ﬁ g |n ’q] ’w | h ’ Structural Elements ' Wall

@ ,

+
oo

v

J@l

&

]

<44 [

I

Room Elements ‘I B Door
Others *I E Window
@ 7[ M Stairs ric

+ [ &

=% Tags /Memberships

T

= V. Sel.:Rel.:0 /Ways:1 /Nod¢
%2 0 (6 nodes)
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A new window appears. In this window, you have to enter the fields. It should be self-explaining.

Decimal marker is a point, not a comma: 25 2 2.5
Do only write the values in the field, not the units: “2.5-m”, “2.5-meters” > 2.5

e |
k-

Please enter the height of the wall in meters {e.qg. 2.5).

Height of the wall: |2. 5 |

‘ <= Apply Preset H eﬂalcel ‘

When finished entering the values, click “Apply Preset”.

.
miterreg © TH§
BEE

Now you can draw the next element. Draw an element that shares a border with your first element.

When drawing, make sure that the points turn red like when closing an area (and an arrow

appears). This is called snapping. Snapping makes sure that there is no empty space between e.g.

a wall and a window:

www.alpine-space.eu/THE4BEES
This project is co-financed by the European Regional Development Fund
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For some elements, there is a clickable link (“More information about this feature”) that provides
help for the entry of the values:

ﬁ(‘.hange 1 41;-{&11 A . u
I

WINDOW

Please enter the height from the ground to the lower edge of the wall in meters {e.qg. 1.50).

Lower height of the window: |1. 5 |

Please enter the height from the ground to the upper edge of the wall in meters {e.g. 2.0).

Upper height of the window (wall below + window): |2.U |

Please enter the total height from the ground to the ceiling, induding the window (e.qg. 2.5).

Total height {wall below + window + wall above): |2. g |

More information about this feature

‘ @ApplyPreset H QCancel ‘

It is good practice to draw element by element and directly assign the correct preset. Otherwise,
there is a high chance that you might forget to attribute an element.

Make sure to save your edits frequently, in case the program crashes or something goes wrong.
You can save your drawing with File - Save as...

Name your file like this:

NameOfSchool_FloorNumber.osm - e.g. HTBLUVA_floorl.osm

For “Files of type”, choose “OSM Server Files (*.osm)” and click save.

www.alpine-space.eu/THE4BEES 32
This project is co-financed by the European Regional Development Fund
through the Interreg Alpine Space programme




If you want to interrupt your drawing session and continue later, click on “File = Exit”, uncheck the
“upload”-action and check “Save”. Then, click on “Save Session As...”, leave the next window as it
is and click “save as”. Give your project a name and choose a location to save and save your *.jos

Session-file.

witerreg ©
Alpine Space

— T
'X Unsaved changes - Save/Upload before exiting?
— —

Layer Name and File Path
/) Data Layer 1

E] ..\15_THE4BEES\josm'Prezetz\0SM-Files\DeCaro_floor 1.osm

Recommended Actions

should be uploaded

Actions To Take

Upload

e

| .&B Perform actions before exiting

| B Exit now!

Savein: [ | O5M-Files

-
e

Zuletzt verw...

-

Desktop

| @: File name: |MyProject_FIoorl|

Files of type: [E.ession file (*.jos)

Next time you start JOSM, go to “File > Open Recent” and choose your file.

www.alpine-space.eu/THE4BEES
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To make drawing of the tables easier, we use a little “workaround” as there currently is no other

(easy) way to draw the tables.

To do so, go to “Data - Set buildings size” and click on “Advanced...”
In the next window, there is one element in a table: Key:“building”, value: “yes”.
Click on “building” and delete it, then do the same with “yes”, so that the table is empty:

':( Advanced settings

(]

Buildings tags:

m ==

Key

Value

[
]

Then click “Ok”.

Big buildings mode
Rotate crosshair

| So ]| @ | .

Now, you can use the tool to draw your tables. For “buildings width”, enter the length of the table,
e.g. 1 m, for the length step, enter the width of the table, e.g. 0.5 m:

“¥ Set buildings size e

Buildings width:
Length step:

Use address nodes under buildings

1

0.5

Use Address dialog
Auto-select building
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Use the “Draw Buildings™-Tool to draw your first table:

File Edit View Tools Data Selection Presets Imagery Windows Aud

BAS

@ ||y e |HE
e |
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-
TH

pec

Select the table and use the preset for a table, enter the attributes. If you have more tables with the
same size, select your table, press “CTRL + C” and “CTRL + V”. When you select the new table,

you can drag and drop it to its correct position:

A @EHHEY R HY Wi~

+ | & [ = AN |

@ % Tags: 3/ Membershps: 0 )
Key valve
fsubtype table
[trpe [funitureFeature
[ & add I PEdt Bosee |
@ V] Sel.:Rel.:0 / Ways:1/Nodes:0 o
T4 0 (4 nodes) i

R [ [chseach v 9 Hstory |
@ Reltons [l
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The same tool can also be used to draw the chalkboard and radiators (if available).

EEEE

The beacon as “display element” should be located near the main door and have a size of 0.1 x 0.1

m.

& For the Room-name, do not use any comma or semi-colon. Spaces are ok.

m Change 1 cbject u
I

BEACON

Flease enter the Room-MNumber,

Room-4umber: | 100, 125E |

Flease enter a name for the room (e.0. Classroom of 6a)

Room-ame: |Classruum of 4b |

Please select the carrect type for the room

Foom-Type: I lecture | - |

@hpplyPreset | ﬁCamel ‘

CEE—— .

www.alpine-space.eu/THE4BEES
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The following image shows how a fully drawn room might look like:

" * Java OpenStreetMap Editor

.
miterreg @

Alpine Space BEE

Eile Edit View Tools Data

Presets Imagery Windows Audio Help

B EEEm

X @

ToeR<Rs

b adg &G

Saneozmer  (Dezawsss  (I-

Baolsela@av B HERBD I @G HY Wk

@ Layess HE
© =P

L APY Openstreetiap Carto (Standard layer

e ¢ & | %A .8

@ % Tags /Memberships #o

Select objects for which to change tags.

[ + add | Beo [ @ose= |

@ V. Selection HE

Tnsded v|[ Ighsewch v)  Mteoy |
@ Relatons B2

] ’——T——‘ =
D Opansusatiday contibutonrs, CC-B 55 I] . “i*#

This should be done for every room and every floor.

www.alpine-space.eu/THE4BEES

| {Move objects by dragoing; Shift to add to selection (Ctr o toggie); St to rotate selected; Alt-Cil to scale selected; o change selecton
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He+ SAVE YOUR FINISHED BUILDING MODEL

When you finished drawing your building, please save it as *.osm with the same name as before in
Chapter “G”. This file is your final file and should be provided to iSPACE for further processing.
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